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Information in this document, including URL and other Internet website 
references, is subject to change without notice. Unless otherwise noted, 
the companies, organizations, products, domain names, e-mail addresses, 
logos, people, places, and events depicted in examples herein are fic-
titious. No association with any real company, organization, product, 
domain name, e-mail address, logo, person, place, or event is intended 
or should be inferred. Complying with all applicable copyright laws is the 
responsibility of the user. Without limiting the rights under copyright, no 
part of this document may be reproduced, stored in or introduced into a 
retrieval system, or transmitted in any form or by any means (electronic, 
mechanical, photocopying, recording, or otherwise), or for any purpose, 
without the express written permission of Microsoft Corporation. 

Microsoft may have patents, patent applications, trademarks, copy-
rights, or other intellectual property rights covering subject matter 
in this document. Except as expressly provided in any written license 
agreement from Microsoft, the furnishing of this document does not 
give you any license to these patents, trademarks, copyrights, or other 
intellectual property.

© 2010 Microsoft Corporation.

Microsoft, Expression, Expression Blend, PlayReady, PowerPoint, 
SharePoint, Silverlight, Windows, Windows Media, and Visio are 
either registered trademarks or trademarks of the Microsoft group of 
companies.

Adobe and Photoshop are registered trademarks of Adobe Systems 
Incorporated in the United States and/or other countries.

Macintosh and Safari are registered trademarks of Apple Incorporated 
in the United States and/or other countries.

All other trademarks are property of their respective owners.
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Expression Studio Ultimate edition includes: Expression Blend® 
+ SketchFlow, Expression Web, Expression Encoder Pro, and 
Expression Design.

Expression Studio Premium edition includes: Expression Web, 
Expression Blend, Expression Encoder, and Expression Design.

Expression Studio Web Professional edition includes: Expression 
Web, Expression Encoder, and Expression Design.

Microsoft Expression Studio 4 Editions
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Learning and Community Resources

In addition to the User Guides (on the Help menu for each Expres-
sion product), the following content and resources are available:

Expression community website  
expression.microsoft.com

Expression discussion forums 
social.expression.microsoft.com/forums

Expression gallery 
gallery.expression.microsoft.com

Expression library 
msdn.microsoft.com/library

Feedback and bug reporting center 
connect.microsoft.com/expression

Microsoft Help and Support 
support.microsoft.com/oas

•

•

•

•

•

•
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Using Microsoft Expression Web 4, you can design, develop, 
and publish compelling, feature-rich websites that conform to 
web standards.

The Expression Web SuperPreview online service expands 
cross-browser testing to include more browsers and operating 
systems than in previous versions. The SEO Checker ana-
lyzes your site and generates reports to help identify ways to 
improve the ranking of your site in search-engine results.

For a complete list of new features, see “What’s new” in the  
Expression Web User Guide (on the Help menu).
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SuperPreview Online Service
The Expression Web SuperPreview online service is a beta service 
that extends the capability of SuperPreview to include support 
for additional browsers and operating systems, such as Safari® 
on Macintosh®.

Now you can see how your page will look—even on a different 
operating system.

For more information about the SuperPreview online service, 
see “Displaying pages in SuperPreview” in the Expression Web 
User Guide.
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1	 Superpreview	Online	Service
You can enable the online service to view a page in another operating 
system or in a browser that isn’t installed on your computer.

2	 OperATinG	SYSTeM	nATive	cOnTrOlS
If you choose a browser in another operating system, your page renders 
with the native controls for that operating system.

3	 SYnTAX	cOlOrinG	in	DOM	view
Keywords are displayed in color in the DOM view, helping you to 
more quickly find the properties for a tag.
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SEO Checker
The SEO Checker helps you optimize the pages in your site 
for discovery and indexing by search engines. Pages that fol-
low good Search Engine Optimization (SEO) guidelines rank 
higher in search-engine results, helping people find your site 
more easily.

You can choose SEO options, display an SEO report, filter the 
results in the SEO report, and step forward and back through 
the list of results in the SEO report to see more detail for indi-
vidual list items.

For more information about the SEO Checker, see “Search 
Engine Optimization” in the Expression Web User Guide.
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Extensibility
Expression Web includes a new Software Development Kit 
(SDK) that you can use to extend the capabilities of Expression 
Web.

New for version 4, Expression Web introduces a JavaScript 
Application Programming Interface (API) and a JavaScript 
bridge to the managed code API. Developing extensions in 
JavaScript and HTML is familiar to web developers, which makes 
it easier than developing extensions in managed or native code. 

In addition to using the JavaScript files that provide the logic 
for an add-in, you can construct panels, dialog boxes, and oth-
er display elements for your add-in using HTML and CSS. And 
because you’re using web technology, you can use Expression 
Web as your development environment. 

For more information about extensibility in Expression Web, 
see “Getting started” in the Expression Web SDK User Guide.
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With Microsoft Expression Blend 4, you can create websites and 
applications based on Microsoft Silverlight® 3 and Microsoft 
Silverlight 4, and desktop applications based on Windows® 
Presentation Foundation (WPF) 3.5 with Service Pack 1 (SP1) and 
WPF 4.

Expression Blend introduces new SketchFlow features. Using 
Publish to SharePoint, you can share feedback among multiple 
reviewers for Silverlight projects. You can also use Team 
Foundation Server (TFS) services to create work items from 
feedback in both Silverlight SketchFlow projects and WPF 
SketchFlow projects. SketchFlow is available only in Expres-
sion Studio Ultimate.

New graphics tools and support in Expression Blend include a new 
Shapes category in the Assets panel, path layout, shader effects 
during state transitions, and support for Adobe® Photoshop® 
layer effects. Expression Blend 4 also offers support for RichText-
Box controls in Silverlight projects.

Expression Blend also includes new behaviors that are quickly 
and easily configured, making it easier to add interactivity 
without knowing any code. To support the development of 
line-of-business (LOB) applications, Expression Blend introduces 
support for Views and ViewModels.

For a complete list of new features, see “What’s new” in the  
Expression Blend User Guide (on the Help menu).
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Publish to SharePoint with SketchFlow 
(Expression Studio Ultimate only)

After you have created a Silverlight SketchFlow project, you 
can publish your project to a Microsoft SharePoint® document 
library. The SketchFlow project will be available to anyone who 
has read-only permission to view content on the SharePoint 
site. Reviewers with read/write permission will be able to publish 
feedback for the prototype to the SharePoint site.

Reviewers can leave their feedback in the SketchFlow Player, 
and then share their feedback with other stakeholders by pub-
lishing their feedback to the SharePoint site. Designers can 
then open the shared feedback from within Blend.

For more information about publishing to SharePoint, see 
“Publish to SharePoint” in the Expression Blend User Guide.
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1	 MY	FeeDbAck	pAnel
The feedback that you leave in the SketchFlow Player appears in the 
My Feedback panel.

2	 ShAreD	pAnel
The feedback that others publish to SharePoint appears in the 
Shared panel.

3	 SkeTchFlOw	FeeDbAck	pAnel
A designer working in Expression Blend can view all the shared 
feedback in the SketchFlow Feedback panel.
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SketchFlow Integration with TFS 
(Expression Studio Ultimate only)

If the SketchFlow project that you are working on is being 
tracked by Team Foundation source control, you can quickly 
create a work item from a .feedback file. When you convert 
feedback to a work item, a screen shot of the screen that the 
feedback applies to is added to the work item, and information 
about the work item is included in the work-item template. You 
can add or modify the information directly in the work-item 
template.

For more information about publishing to SharePoint, see 
“Convert feedback into a Team Foundation work item” in the 
Expression Blend User Guide.
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Export Feedback to Microsoft Word 
(Expression Studio Ultimate only)

You can now include feedback for a SketchFlow project in the 
Microsoft Word document when you export your SketchFlow 
feedback to Word. In addition to feedback, the Word docu-
ment will include a table of contents, a list of figures, the 
SketchFlow map, each screen in the application flow, and all 
associated annotations.

For more information about exporting your project to Word, see 
“Export to Microsoft Word” in the Expression Blend User Guide.
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Path Layout

A new feature of Expression Blend is the ability to lay out items 
along any path using the PathListBox control. The path can 
be any element and can be of any size or shape. Items can be 
arranged along the path according to several settings that can 
be animated. By animating the Start property, you can also use 
this feature in motion path scenarios.

Once you have created your list, you can add PathListBoxItems 
explicitly, or add a data source from the Data panel.

For more information about path layout, see “Lay out items 
along a path” in the Expression Blend User Guide.
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1	 pAThliSTbOX	in	The	ObjecTS	AnD	TiMeline	pAnel
After you add a PathListBox to the project, the path appears in the 
Objects and Timeline panel.

2	 lAYOuT	pAThS	in	The	prOperTieS	pAnel
You can configure the path by using the Layout Paths category in the 
Properties panel.
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Behaviors

You can add interactivity to your application, without having to 
write code, by using behaviors. Behaviors are reusable compo-
nents that can be directly applied to any object on the artboard, 
and they are composed of extensible triggers, extensible actions, 
and other behaviors.

Expression Blend includes the new TranslateZoomRotateBehav-
ior multi-touch behavior, and a PanningItems control that you 
can use to scroll between items by using touch. Expression Blend 
also has a new trigger that responds to a frame change or the 
pausing or completion of a SketchFlow* animation, called the 
SketchFlowAnimationTrigger. Expression Blend has new sets of 
behaviors for dragging items between list boxes, for modifying 
menu navigation, and for preserving data across screen states, 
such as SetDataStoreValueAction and DataStoreChangedTrigger. 

An exciting enhancement has been made to the FluidMove-
Behavior: if you apply it to different views of the same data 
item, when the item moves from one view to another (for 
example, from a list view to a details view), it fluidly animates 
the transition between the two views.

For more information about behaviors, see “Working with 
behaviors” in the Expression Blend User Guide.

*SketchFlow is available only in Expression Studio Ultimate.
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Data and Resources

Expression Blend makes it easy to prototype, build, and test 
data-connected applications even when run-time data and 
resources are not available.

Data Context

The Data Context category on Data panel provides a view 
of the data context of an object, whether design-time or 
run-time, and lets you drag properties, commands, and 
methods onto the design surface to bind your user interface 
(UI) to them.

Design-Time ViewModels

If your application uses Views and ViewModels patterns, you 
can use the Create Sample Data From Class command in the 
Data panel to generate design-time sample ViewModels so 
that you can continue to design your application in the context 
of this data.

Easier Element-To-Element Property Binding

It’s easier than ever to use the Advanced options in the 
Properties panel to bind element properties together.

For more information about working with data, see “Displaying 
data” in the Expression Blend User Guide.
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Photoshop Layer Effects

You can now import layer effects from Photoshop. If a layer effect 
has been applied to a layer, the Layer effect icon appears next to 
the layer in the Import Adobe Photoshop File dialog box. A 
layer effect can be imported either by selecting the Flattened 
bitmap import option or by merging the layer with other layers.

For more information about importing layer effects, see 
“Import Photoshop and Illustrator files” in the Expression 
Blend User Guide.

Transition Effects

After you have created a user control and defined state 
changes for that user control, you can quickly and easily add 
a transition effect by applying one of the built-in transition 
effects available in Expression Blend, or you can use a custom 
transition effect.

For more information about transition effects, see “Apply a 
transition effect to a visual state change” in the Expression 
Blend User Guide.
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Shapes

You can add a variety of common shapes such as callouts, stars, 
rings, and arrows directly from the Assets panel by clicking 
Shapes, and then clicking the shape that you want. You can 
animate shapes and bind data to shape properties after you 
add them to the artboard. 

For more information about shapes, see “Draw a shape or path 
in your project” in the Expression Blend User Guide.

Rich Text Boxes

Expression Blend has tooling support for the RichTextBox 
control in Silverlight.

For more information about working with RichTextBox con-
trols, see “Add an object to the text flow” in the Expression 
Blend User Guide.SO
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Microsoft Expression Encoder 4 is a program for creating high-
quality audio and video that you can play back, or stream, 
seamlessly from the web, using Internet Information Services 
(IIS) Smooth Streaming* technology. Expression Encoder gen-
erates high-quality VC-1-encoded and, in Expression Encoder 
Pro**, H.264-encoded content. This content integrates well 
with the rich-media, interactive-presentation capabilities of 
Microsoft Silverlight. You can also use the Expression Encoder 
Screen Capture application to capture activity on your screen, 
and then save it to stream or edit further in Expression Encoder. 
This version adds the ability to streamline your workflow by 
working in one of three project-specific workspaces: Transcod-
ing Project, Silverlight Project, or Live Broadcasting Project.

Expression Encoder Pro adds the ability to use Digital Rights 
Management (DRM) protection for your smooth streaming* 
content. Using the tools in Expression Encoder, you can encrypt 
and encode files that are compatible with Microsoft PlayReady 
technology. With DRM, you can be confident that your media 
will be used only as you specify.

For a complete list of new features, see “What’s new” in the  
Expression Encoder User Guide (on the Help menu).

*Available in Expression Encoder Pro only.

**Not available in the DreamSpark or MSDN versions of  
Expression Encoder Pro.
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Create Live Smooth Streaming Broadcasts  
(Expression Encoder Pro Only)

In a Live Broadcasting Project, you can set your live production 
to broadcast using Live Smooth Streaming technology. This tech-
nology is the Microsoft implementation of adaptive streaming 
technology, which is a form of audio/video web-based content 
delivery that uses HTTP progressive download technology. 
Live Smooth Streaming content is encoded into streams of 
several different quality levels. During playback, this content 
is dynamically monitored for local bandwidth and video ren-
dering performance. Depending on the resources available, 
Smooth Streaming will play back the encoded stream that 
best matches the available bandwidth. Expression Encoder 
includes templates that have the ability to monitor network 
bandwidth, CPU load, and screen resolution, and, based on 
the conditions, select the stream that will playback smoothly. 
Now, your users can receive your real-time broadcasts, and 
those broadcasts maintain glitch-free playback even when 
network bandwidths fluctuate.

Live Smooth Streaming is the live broadcasting extension of 
On-Demand Smooth Streaming. It uses the same encoding 
methods and creates the same file types. You can encode 
your Live Smooth Streaming broadcasts using either VC-1 or 
H.264* codecs.

For more information, see “About Live Smooth Streaming” in 
the Expression Encoder User Guide.

*Not available in the DreamSpark or MSDN versions of  
Expression Encoder Pro.
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1	 iiS	SMOOTh	STreAMinG
Select IIS Smooth Streaming as your Output Format in order to 
perform Live Smooth Streaming.

2	 publiShinG	pOinT
Type the publishing point where your live broadcast will be streamed.

3	 brOADcASTinG
If you view the broadcast in a graphing Silverlight player, you can see 
frame rate, bit rate, and CPU load information that adjusts dynami-
cally depending on network conditions.
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Protect Your IIS Smooth Streaming Content  
with Digital Rights Management  
(Expression Encoder Pro Only)

Digital Rights Management (DRM) is a technology that you can 
use to protect your distributed content. You can use the tools 
in Expression Encoder to create DRM-encrypted files that are 
compatible with Microsoft PlayReady®. Once you implement 
DRM in your content, anyone who wants to view it must have 
a license. The process of playback is handled by both the client 
application and the license server. In addition, you can specify 
what actions the user can perform with your content, from 
merely playing it back to possibly copying and distributing 
your content.

After implementing DRM, you can freely post your content to 
your web server, or you can broadcast it live, with the confi-
dence that your content will not be used in any way other than 
what you have specified. The licensing can be specific to your 
location, your device, or your network domain, meaning that 
you can specify even the environment in which your content 
will play back.
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1	 The	SecuriTY	cATeGOrY
Enter your DRM encryption information here before you encode 
your file.

2	 prOTecTeD	plAYbAck	view
Your content plays back only for users licensed to use it.
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Create Content in Specifically Designed 
Workspaces

In Expression Encoder 4, you have a choice of three different 
workspaces in which to assemble your media. These work-
spaces are called projects. Each project presents a unique 
layout and appearance, and each includes all the tools you 
need to create the output associated with that project. With 
the exception of screen capture, you will do all your work in 
Expression Encoder in a project. 

Create a Transcoding Project to quickly access the tools 
you need to build, edit, and encode your job as VC-1, H.264 
(Expression Encoder Pro* only), or Smooth Streaming files 
(Expression Encoder Pro only), suitable for playback online or 
on devices. 

Create a Silverlight Project if you want to encode media that 
is compatible with Silverlight and that is embedded in a rich, 
interactive Silverlight template.

Create a Live Broadcasting Project if you want to assemble 
audio and video content on the fly that you can then broadcast 
to many different clients using Smooth Streaming technology 
(Expression Encoder Pro only). You can also choose to save this 
broadcast to a file for later editing, streaming, or combining with 
other digital media content.

For more information, see “Working with projects” in the 
Expression Encoder User Guide.

*Not available in the DreamSpark or MSDN versions of  
Expression Encoder Pro.
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1	 The	new	prOjecT	DiAlOG	bOX
Choose a project to work in. You can also choose from recent jobs or 
browse to a specific job.

2	 A	TrAnScODinG	prOjecT
In this project, you can use various tools to edit and encode your video.

3	 A	SilverliGhT	prOjecT
In this project, you can quickly choose Silverlight templates.

4	 A	live	brOADcASTinG	prOjecT
In this project, you can assemble live and saved sources and create a 
live broadcast from them.
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Work with DXFP Caption Files

Expression Encoder adds the ability to import text files that 
contain capture and subtitle data, such as SUB, SRT, SAMI, 
DXFP, and LRC files. Once the files have been imported, you 
can then output the media content, along with the caption 
files, into a single Silverlight package. Using an Expression 
Encoder template, you can then display the captions during 
playback. Expression Encoder will preserve the format and 
styling of your original DFXP files and provide uniform for-
matting for your SUB, SRT, SAMI, and LRC files.

Use New Live Broadcasting Panels to Monitor 
Your Content

Live Broadcasting gets an overhaul in Expression Encoder 4 
with a redesigned user interface that adds a Connections 
panel that keeps track of all the network connections that are 
occurring as you stream your content. You can also use the 
new Statistics panel to dynamically track the various input and 
output functions that occur as you create your live broadcast.

SO
LO

 N
ETW

O
R

K



�1

Refine Your MP4 Encoding with Expanded H.��4 
Options (Expression Encoder Pro* Only)

Expression Encoder 4 adds new parameters that give you 
more control over the quality of the compression of your 
H.264-encoded content. Along with increased performance, 
you now have more control over such parameters as reference 
B-frames, adaptive B-frames, and scene-change detection.

*Not available in the DreamSpark or MSDN versions of  
Expression Encoder Pro.

Create Multicast-Compatible Broadcasts

Expression Encoder 4 adds the ability to generate a stream 
format file, which is necessary for you to multicast your multi-
cast-compatible content. Now, your content can take advan-
tage of multicast functionality after you have set a multi-cast 
publishing point on a Windows Media® Server.SO

LO
 N

ETW
O

R
K



SO
LO

 N
ETW

O
R

K



��

Microsoft Expression Design 4 is an application for creative 
professionals and developers who want to build graphics for 
application user interfaces, the web, or any other medium.

This version adds the ability to import Windows Metafile 
(WMF), Enhanced Metafile (EMF), and Enhanced Metafile Plus 
(EMF+) files into your Expression Design project. After you 
import them, you have full control over the vector paths and 
also any clipping paths in the images. 

Expression Design 4 also adds the ability to save your workspace, 
which is your specific layout of panels. You can now save work-
spaces that can accommodate the variety of projects that you 
may work on, or the variety of working scenarios that you may 
work in, such as using multiple monitors or smaller monitors.

For a complete list of features, see “What’s new” in the  
Expression Design User Guide (on the Help menu).
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Import Windows Metafile and Enhanced  
Metafile Documents

You can import Windows Metafile (WMF), Enhanced Meta-
file (EMF), and Enhanced Metafile Plus (EMF+) files into your 
Expression Design project. WMF and EMF files are highly por-
table files that contain vector-based graphics that are commonly 
created by using the art and illustration tools in Microsoft Office 
applications, such as Office Word and Office Visio®. For example, 
Office Word uses the EMF format to create WordArt images, and 
the slides and charts created in Office PowerPoint® use this for-
mat also. The metafile formats can store complex, rich image data 
in relatively small files.

1	 cOpY	A	wMF	Or	eMF	DrAwinG
You can use various WordArt features to create an image, as here, or 
you can create an image in any application that supports WMF or 
EMF files.

2	 pASTe	YOur	ArT	inTO	eXpreSSiOn	DeSiGn
Note that Expression Design displays all the control points for vector 
artwork. You can also import your art from the File menu, drag it from 
another program, or open it directly in Expression Design. Each path 
appears in the Layers panel, along with clipping masks, for full control 
over editing your art.
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